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ABSTRACT:

This project presents the overall design of Home Automation System (HAS) with low
cost and wireless system. It specifically focuses on the development of an 10T based home
automation system that is able to control various components via internet or be automatically
programmed to operate from ambient conditions. In this project, we design the development of
a firmware for smart control which can successfully be automated minimizing human
interaction to preserve the integrity within whole electrical devices in the home. We used Node
MCU, a popular open source 10T platform, to execute the process of automation. Different
components of the system will use different transmission mode that will be implemented to
communicate the control of the devices by the user through Node MCU to the actual appliance.
The main control system implements wireless technology to provide remote access from smart
phone. We are using a cloud server-based communication that would add to the practicality of
the project by enabling unrestricted access of the appliances to the user irrespective of the
distance factor. We provided a data transmission network to create a stronger automation. The
system intended to control electrical appliances and devices in house with relatively low cost
design, user-friendly interface and ease of installation. The status of the appliance would be
available, along with the control on an android platform. This system is designed to assist and
provide support in order to fulfil the needs of elderly and disabled in home. Also, the smart

home concept in the system improves the standard living at home
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CHAPTER 1

EMBEDDED SYSTEMS
1.1. INTRODUCTION TO EMBEDDED SYSTEMS

An embedded system is a special-purpose computer system designed to perform one or
a few dedicated functions, sometimes with real-time computing constraints. It is usually
embedded as part of a complete device including hardware and mechanical parts. In contrast,
a general-purpose computer, such as a personal computer, can do many different tasks
depending on programming. Embedded systems have become very important today as they

control many of the common devices we use.

Since the embedded system is dedicated to specific tasks, design engineers can optimize
it, reducing the size and cost of the product, or increasing the reliability and performance. Some
embedded systems are mass-produced, benefiting from economies of scale.

Physically embedded systems range from portable devices such as digital watches and
MP3 players, to large stationary installations like traffic lights, factory controllers, or the
systems controlling nuclear power plants. Complexity varies from low, with a single
microcontroller chip, to very high with multiple units, peripherals and networks mounted inside

a large chassis or enclosure.

In general, "embedded system™ is not an exactly defined term, as many systems have
some element of programmability. For example, Handheld computers share some elements
with embedded systems — such as the operating systems and microprocessors which power
them — but are not truly embedded systems, because they allow different applications to be

load and peripherals to be connected.

An embedded system is some combination of computer hardware and software, either
fixed in capability or programmable, that is specifically designed for a particular kind of
application device. Industrial machines, automobiles, medical equipment, cameras, household
appliances, airplanes, vending machines, and toys (as well as the more obvious cellular phone
and PDA) are among the myriad possible hosts of an embedded system. Embedded systems
that are programmable are provided with a programming interface, and embedded systems

programming is a specialized occupation. Certain operating systems or language platforms are

Page 3



IOT BASED HOME AUTOMATION

tailored for the embedded market, such as Embedded Java and Windows XP Embedded.
However, some low-end consumer products use very inexpensive microprocessors and limited
storage, with the application and operating system both part of a single program. The program
IS written permanently into the system's memory in this case, rather than being loaded into

RAM (random access memory), as programs on a personal computer are.
1.2. CHARACTERISTIC OF EMBEDDED SYSTEM

e Speed (bytes/sec): Should be high speed

Power (watts): Low power dissipation

e Size and weight: As far as possible small in size and low weight
e Accuracy (%error): Must be very accurate

e Adaptability: High adaptability and accessibility

e Reliability: Must be reliable over a long period of time
1.3. APPLICATIONS OF EMBEDDED SYSTEMS

We are living in the Embedded World. You are surrounded with many embedded products
and your daily life largely depends on the proper functioning of these gadgets. Television,
Radio, CD player of your living room, Washing Machine or Microwave Oven in your kitchen,
Card readers, Access Controllers, Palm devices of your work space enable you to do many of
your tasks very effectively. Apart from all these, many controllers embedded in your car take
care of car operations between the bumpers and most of the times you tend to ignore all these

controllers.

¢ Robotics: industrial robots, machine tools, Robocop soccer robots
e Automotive: cars, trucks, trains

e Aviation: airplanes, helicopters

e Home and Building Automation

e Aerospace: rockets, satellites

e Energy systems: windmills, nuclear plants

e Medical systems: prostheses, revalidation machine.
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1.4. MICROCONTROLLER VERSUS MICROPROCESSOR

What is the difference between a Microprocessor and Microcontroller? By
microprocessor is meant the general purpose Microprocessors such as Intel's X86 family (8086,
80286, 80386, 80486, and the Pentium) or Motorola's 680X0 family (68000, 68010, 68020,
68030, 68040, etc). These microprocessors contain no RAM, no ROM, and no I/O ports on the

chip itself. For this reason, they are commonly referred to as general-purpose Microprocessors.

A system designer using a general-purpose microprocessor such as the Pentium or the
68040 must add RAM, ROM, 1/O ports, and timers externally to make them functional.
Although the addition of external RAM, ROM, and I/O ports makes these systems bulkier and
much more expensive, they have the advantage of versatility such that the designer can decide
on the amount of RAM, ROM and 1/O ports needed to fit the task at hand. This is not the case

with Microcontrollers.

A Microcontroller has a CPU (a microprocessor) in addition to a fixed amount of RAM,
ROM, I/O ports, and a timer all on a single chip. In other words, the processor, the RAM,
ROM, 1/0 ports and the timer are all embedded together on one chip; therefore, the designer
cannot add any external memory, 1/0 ports, or timer to it. The fixed amount of on-chip ROM,
RAM, and number of 1/O ports in Microcontrollers makes them ideal for many applications in

which cost and space are critical.

In many applications, for example a TV remote control, there is no need for the
computing power of a 486 or even an 8086 microprocessor. These applications most often

require some 1/O operations to read signals and turn on and off certain bits
1.5. MICROCONTROLLERS FOR EMBEDDED SYSTEMS

In the Literature discussing microprocessors, we often see the term Embedded System.
Microprocessors and Microcontrollers are widely used in embedded system products. An
embedded system product uses a microprocessor (or Microcontroller) to do one task only. A
printer is an example of embedded system since the processor inside it performs one task only;
namely getting the data and printing it. Contrast this with a Pentium based PC. A PC can be
used for any number of applications such as word processor, print-server, bank teller terminal,
Video game, network server, or Internet terminal. Software for a variety of applications can be
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loaded and run. Of course the reason a pc can perform myriad tasks is that it has RAM memory
and an operating system that loads the application software into RAM memory and lets the
CPU run it.

In this robot as the fire sensor senses the fire, it senses the signal to microcontroller. In
an Embedded system, there is only one application software that is typically burned into ROM.
An x86 PC contains or is connected to various embedded products such as keyboard, printer,
modem, disk controller, sound card, CD-ROM drives, mouse, and so on. Each one of these

peripherals has a Microcontroller inside it that performs only one task.
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CHAPTER 2

INTRODUCTION TO PROJECT
2.1. INTRODUCTION

BLOCK DIAGRAM

Power 16%2
LCD
Supply
Relayl Loadl
Arduino
UNO
DHT11
Relay2 Load?2
loT

Figure.2.1. Block Diagram
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CHAPTER 3
ARDUINO UNO

3.1 Microcontroller:
3.1.1 Introduction:

Microcontroller as the name suggest, a small controller. They are like single chip
computers that are often embedded into other systems to function as processing/controlling
unit. For example, the control you are using probably has microcontrollers inside that do
decoding and other controlling functions. They are also used in automobiles, washing

machines, microwaves ovens, toys....etc, where automation is needed.
3.1.2 Arduino Uno Microcontroller:

The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It
has 14 digitalinput/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16
MHz crystal oscillator, a USB connection, a power jack, an ICSP header, and a reset button. It
contains everything needed to support the microcontroller; simply connect it to a computer

with a USB cable or power it with a AC-to-DC adapter or battery to get started.

The Uno differs from all preceding boards in that it does not use the FTDI USB-to-
serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial
converter. "Uno" means "One" in Italian and is named to mark the upcoming release of Arduino
1.0. The Uno and version 1.0 will be the reference versions of Arduino, moving forward. The
Uno is the latest in a series of USB Arduino boards, and the reference model for the Arduino

platform; for a comparison with previous versions, see the index of Arduino boards.

The Arduino Uno can be powered via the USB connection or with an external power
supply. The power source is selected automatically. External (non-USB) power can come either
from an AC-to-DC adapter (wall-wart) or battery. The adapter can be connected by plugging a
2.1mm center-positive plug into the board's power jack. Leads from a battery can be inserted
in the Gnd and Vin pin headers of the POWER connector. The board can operate on an external
supply of 6 to 20 volts. If supplied with less than 7V, however, the 5Vpin may supply less than
five volts and the board may be unstable. If using more than 12V, the voltage regulator may

overheat and damage the board. The recommended range is 7 to 12 volts
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The power pins are as follows:

e VIN. The input voltage to the Arduino board when it's using an external power
source (as opposed to5 volts from the USB connection or other regulated power
source). You can supply voltage through this pin, or, if supplying voltage via
the power jack, access it through this pin.

e 5V. The regulated power supply used to power the microcontroller and other
components on the board. This can come either from VIN via an on-board
regulator, or be supplied by USB or another regulated 5V supply.

e 3.3V.A 3.3volt supply generated by the on-board regulator. Maximum current
draw is 50 mA.

e GND. Ground pins.

Memory:

The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used
for the bootloader); It has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and
written with the EEPROM library).

Input and Output:

Each of the 14 digital pins on the Uno can be used as an input or output, using
pinMode(), digitalWrite(), and digitalRead() functions. They operate at 5 volts. Each pin can
provide or receive a maximum of 40 mA and has an internal pull-up resistor (disconnected by
default) of 20-50kOhms. In addition, some pins have specialized functions:

e Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data.
These pins are connected to the corresponding pins of the ATmega8U2 USB-to-TTL
Serial chip.

o External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on
a low value, arising or falling edge, or a change in value. See the attach Interrupt()
function for details.

e PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite()

function.
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e SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI
communication, which although provided by the underlying hardware, is not currently
included in the Arduino language.

e LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH
value, the LED is on, when the pin is LOW, it's off.

The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024

different values). By default they measure from ground to 5 volts, though is it possible to
change the upper end of their range using the AREF pin and the analogReference() function.

Additionally, some pins have specialized functionality:

e 12C:4(SDA)and5 (SCL). Support 12C (TWI) communication using the Wire library.
There are a couple of other pins on the board:

e AREF. Reference voltage for the analog inputs. Used with analogReference().

e Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset
button to shields which block the one on the board.

Communication:

The Arduino Uno has a number of facilities for communicating with a computer,
another Arduino, or other microcontrollers. The ATmega328 provides UART TTL (5V) serial
communication, which is available on digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the
board channels this serial communication over USB and appears as a virtual com port to
software on the computer. The '‘8U2 firmware uses the standard USBCOM drivers, and no
external driver is needed. However, on Windows, an *.inf file is required. The Arduino
software includes a serial monitor which allows simple textual data to be sent to and from the
Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted
via the USB-to-serial chip and USB connection to the computer (but not for serial
communication on pins 0 and 1). A SoftwareSerial library allows for serial communication on
any of the Uno’'s digital pins. The ATmega328 also support 12C (TWI) and SPI communication.
The Arduino software includes a Wire library to simplify use of the 12C bus

3.1.3 ARDUINO UNO BOARD:

The Arduino Uno is a microcontroller board based on the ATmega328. It has 14 digital
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz ceramic

resonator, a USB connection, a power jack, an ICSP header, and a reset button. It contains
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everything needed to support the microcontroller; simply connect it to a computer with a USB

cable or power it with a AC-to-DC adapter or battery to get started.

€0 € € € O L1
~ W ! < o~
T 2

DIGITAL (PWM—)

=
@~
=

Figure 3.1: Arduino uno board

The Uno differs from all preceding boards in that it does not use the FTDI USB-to-

serial driver chip. Instead, it features the Atmegal6U2 (Atmega8U2 up to version R2)

programmed as a USB-to-serial converters.

5.1.3.1 Technical Specifications:

FEATURE

SPECIFICATION

Microcontroller
Operating Voltage
Input Voltage
(recommended)

Input Voltage (limits)
Digital 1I/0 Pins

Analog Input Pins

D Current per I/0 Pin
DiC Current for 2.3V Pin

Hash Memory

SRAM
EEPR.CM
Clock Speed

ATmega3Zs
5v

T-12V

6-200

14 (of which & provide PWM output)
5}

40 ma

S50 mA

32 KB (ATmega328) of which 0.5 KB
used by boot loader

2 KB (ATmega328)

1 KB (4Tmega32s8)

16 MHz
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Table 3.1: Arduino uno specifications

The Arduino Uno can be powered via the USB connection or with an external power
supply. The power source is selected automatically. External (non-USB) power can come either
from an AC-to-DC adapter (wall-wart) or battery. The adapter can be connected by plugging a
2.1mm center-positive plug into the board's power jack. Leads from a battery can be inserted
in the Gnd and Vin pin headers of the POWER connector. The board can operate on an external
supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V pin may supply less than
five volts and the board may be unstable. If using more than 12V, the voltage regulator may
overheat and damage the board. The recommended range is 7 to 12 volts.

1. USB Interface:

Arduino board can be powered by using the USB cable from your computer. All you
need to do is connect the USB cable to the USB connection

2. External power supply:

Arduino boards can be powered directly from the AC mains power supply by
connecting it to the power supply (Barrel Jack)

3. Voltage Regulator:

The function of the voltage regulator is to control the voltage given to the Arduino

board and stabilize the DC voltages used by the processor and other elements.
4. Crystal Oscillator:

The crystal oscillator helps Arduino in dealing with time issues. How does Arduino
calculate time? The answer is, by using the crystal oscillator. The number printed on top of the
Arduino crystal is 16.000H9H. It tells us that the frequency is 16,000,000 Hertz or 16 MHz.

5-17.Arduino Reset:

It can reset your Arduino board, i.e., start your program from the beginning. It can reset
the UNO board in two ways. First, by using the reset button (17) on the board. Second, you can

connect an external reset button to the Arduino pin labelled RESET (5).

6-9.Pins (3.3, 5, GND, Vin):
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e 3.3V (6): Supply 3.3 output volt

e 5V (7): Supply 5 output volt

e Most of the components used with Arduino board works fine with 3.3 volt
and 5 volt.

e GND (8)(Ground): There are several GND pins on the Arduino, any of which can
be used to ground your circuit.

e Vin (9): This pin also can be used to power the Arduino board from an

external power source, like AC mains power supply.
10. Analog pins:

The Arduino UNO board has five analog input pins A0 through A5. These pins can
read the signal from an analog sensor like the humidity sensor or temperature sensor and

convert it into a digital value that can be read by the microprocessor.
11. Main microcontroller:

Each Arduino board has its own microcontroller (11). You can assume it as the brain
of your board. The main IC (integrated circuit) on the Arduino is slightly different from board
to board. The microcontrollers are usually of the ATMEL Company. You must know what IC
your board has before loading up a new program from the Arduino IDE. This information is
available on the top of the IC. For more details about the IC construction and functions, you

can refer to the data sheet.

The Atmega8U2 programmed as a USB-to-serial converter. "Uno™ means "One" in
Italian and is named to mark the upcoming release of Arduino 1.0. The Uno and version 1.0
will be the reference versions of Arduino, moving forward. The Uno is the latest in a series of
USB Arduino boards, and the reference model for the Arduino platform; for a comparison with

previous versions, see the index of Arduino boards
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-y
(RESET)PC6 ] 1 28 [ PC5 (ADCS/SCL)
(RXD)PDO[] 2 27 [ PC4 (ADC4/SDA)
(TXD)PD1 ] 3 26 [ PC3 (ADC3)
(INTO) PD2[ ] 4 25 [ PC2 (ADC2)
(INT1)PD3] 5 24 [1PC1 (ADC])
(XCK/T0O)PD4[ ]| & 23 [J pco (ADCO)
vCei] 7 22 [ gND
GND[] 8 21 [ AREF
(XTALI/TOSC1)PB6 [] © 20 [1J Avce
(XTAL2/TOSC2) PB7 [] 10 19 [ PB5 (SCK)
(TLHPD5 [] 11 18 [ ] PB4 (MISO)
(AINO) PD6 [] 12 17 [J PB3 (MOSI'OC2)
(AIN1) PD7 [] 13 16 [0 PB2 (SS/OC1B)
(ICP1) PBO [] 14 15 [J PB1(0C14)

Figure 3.2: Pin diagram
3.1.3.2 Pin Description:
VCC: Digital supply voltage.
GND: Ground.
Port B (PB[7:0]) XTALL/XTAL2/TOSC1/TOSC2:

Port B is an 8-bit bi-directional 1/0 port with internal pull-up resistors (selected for each
bit). The Port B output buffers have symmetrical drive characteristics with both high sink and
source capability. As inputs, Port B pins that are externally pulled low will source current if
the pull-up resistors are activated. The Port B pins are tri-stated when a reset condition becomes

active, even if the clock is not running.

Depending on the clock selection fuse settings, PB6 can be used as input to the inverting

Oscillator amplifier and input to the internal clock operating circuit.

Depending on the clock selection fuse settings, PB7 can be used as output from the

inverting Oscillator amplifier.
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If the Internal Calibrated RC Oscillator is used as chip clock source, PB[7:6] is used as
TOSCJ2:1] input for the Asynchronous Timer/Counter?2 if the AS2 bit in ASSR is set.

Port C (PC[5:0]):

Port C is a 7-bit bi-directional 1/0 port with internal pull-up resistors (selected for each
bit). The PC[5:0] output buffers have symmetrical drive characteristics with both high sink and
source capability. As inputs,

Port C pins that are externally pulled low will source current if the pull-up resistors are
activated. The Port C pins are tri-stated when a reset condition becomes active, even if the

clock is not running.
PC6/RESET:

If the RSTDISBL Fuse is programmed, PC6 is used as an I/O pin. Note that the

electrical characteristics of PC6 differ from those of the other pins of Port C.

If the RSTDISBL Fuse is unprogrammed, PC6 is used as a Reset input. A low level on
this pin for longer than the minimum pulse length will generate a Reset, even if the clock is not

running. Shorter pulses are not guaranteed to generate a Reset.
Port D (PD[7:0]):

Port D is an 8-bit bi-directional 1/0 port with internal pull-up resistors (selected for each
bit). The Port D output buffers have symmetrical drive characteristics with both high sink and
source capability. As inputs, Port D pins that are externally pulled low will source current if
the pull-up resistors are activated. The Port D pins are tri-stated when a reset condition becomes

active, even if the clock is not running.

AVCC: AVCC is the supply voltage pin for the A/D Converter, PC[3:0], and PE[3:2]. It should
be externally connected to VCC, even if the ADC is not used. If the ADC is used, it should be
connected to VCC through a low-pass filter. Note that PC[6:4] use digital supply voltage, VCC.

AREF: AREF is the analog reference pin for the A/D Converter.

ADC [7:6] (TQFP and VFQFN Package Only): In the TQFP and VFQFN package,
ADCJ7:6] serve as analog inputs to the A/D converter. These pins are powered from the analog

supply and serve as 10-bit ADC channels.

Page 15



IOT BASED HOME AUTOMATION

12. ICSP pin: Mostly, ICSP (12) is an AVR, a tiny programming header for the Arduino
consisting of MOSI, MISO, SCK, RESET, VCC, and GND. It is often referred to as an SPI
(Serial Peripheral Interface), which could be considered as an "expansion” of the output.

Actually, you are slaving the output device to the master of the SPI bus.

13. Power LED indicator: This LED should light up when you plug your Arduino into a
power source to indicate that your board is powered up correctly. If this light does not turn on,

then there is something wrong with the connection.

14. TX and RX LEDs: On your board, you will find two labels: TX (transmit) and RX
(receive). They appear in two places on the Arduino UNO board. First, at the digital pins 0 and
1, to indicate the pins responsible for serial communication. Second, the TX and RX led (13).
The TX led flashes with different speed while sending the serial data. The speed of flashing

depends on the baud rate used by the board. RX flashes during the receiving process.

15. Digital 1 / O: The Arduino UNO board has 14 digital 1/0 pins (15) (of which 6 provide
PWM (Pulse Width Modulation) output. These pins can be configured to work as input digital
pins to read logic values (0 or 1) or as digital output pins to drive different modules like LEDs,

relays, etc. The pins labeled “~” can be used to generate PWM.

16. AREF: AREF stands for Analog Reference. It is sometimes, used to set an external

reference voltage (between 0 and 5 Volts) as the upper limit for the analog input pins working.
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CHAPTER 4
HARDWARE COMPONENTS

4.1. POWER SUPPLY UNIT

The power supply for this system is shown below.

WA N VN
V\‘ V\, Tout
O— —
g
AC line 301:1:1; Rectifier Filter Regulator Vour | Load
O—

E i i

Figure.4.1.power supply
4.1.1. Transformer:

Transformer is a static device used to convert the voltage from one level to another level

without change its frequency. There are two types of transformers

1. Step-up transformer

2. Step-down transformer
Step-up transformer converts low voltage level into high voltage level without change its
frequency.

Step-down transformer converts high voltage level into low voltage level without change its

frequency.
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In this project we using step-down transformer which converts 230V AC to 12V AC [or] 230V
AC to 5V as shown below.

|

Fak ol

l\—\y 230V AC 12V AC (output)

|
Fak oyl

\j J 230 V AC (output)

I SV AC

Figure.4.2. Transformers

4.1.2. Diodes:
Diodes allow electricity to flow in only one direction. The arrow of the circuit symbol shows

the direction in which the current can flow. Diodes are the electrical version of a valve and

Dt

Figure.4.3. Diode Symbol

early diodes were actually called valves.

A diode is a device which only allows current to flow through it in one direction. In this

direction, the diode is said to be ‘forward-biased' and the only effect on the signal is that there
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will be a voltage loss of around 0.7V. In the opposite direction, the diode is said to be 'reverse-

biased' and no current will flow through it.

4.1.3. Rectifier

The purpose of a rectifier is to convert an AC waveform into a DC waveform (OR) Rectifier
converts AC current or voltages into DC current or voltage. There are two different
rectification circuits, known as "half-wave' and 'full-wave' rectifiers. Both use components
called diodes to convert AC into DC.

The Half-wave Rectifier

The half-wave rectifier is the simplest type of rectifier since it only uses one diode, as shown

in figure.

VOUT

~N />

L

Figure.4.4Half Wave Rectifier
Figure 2 shows the AC input waveform to this circuit and the resulting output. As you can see,
when the AC input is positive, the diode is forward-biased and lets the current through. When
the AC input is negative, the diode is reverse-biased and the diode does not let any current
through, meaning the output is OV. Because there is a 0.7V voltage loss across the diode, the

peak output voltage will be 0.7V less than Vs.
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AC Input

N ANVANS
RVERY,

Rectifier Output

N ANANES

-« -
! !/

Here the wvoltage is OV because
Ry the diode is reverse-biased

Figure.4.5Half-Wave Rectification
While the output of the half-wave rectifier is DC (it is all positive), it would not be suitable as
a power supply for a circuit. Firstly, the output voltage continually varies between 0V and Vs-
0.7V, and secondly, for half the time there is no output at all.

The Full-wave Bridge Rectifier
The circuit in figure 3 addresses the second of these problems since at no time is the output

voltage OV. This time four diodes are arranged so that both the positive and negative parts of

the AC waveform are converted to DC. The resulting waveform is shown in figure 4.

Vs AC INPUT
FROM 1
TRANSFORMER y y
VS- 1.4V
O_
4 DICDES
(I
OUTPUT
O 0V

Figure.4.6. Full-Wave Rectifier
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AC Input

ANAN.
IIRVARY,

Rectifier Output

NANNL

-\

Figure.4.7. Full-Wave Rectification
When the AC input is positive, diodes A and B are forward-biased, while diodes C and D are
reverse-biased. When the AC input is negative, the opposite is true - diodes C and D are
forward-biased, while diodes A and B are reverse-biased.
While the full-wave rectifier is an improvement on the half-wave rectifier, its output still isn't
suitable as a power supply for most circuits since the output voltage still varies between 0V
and Vs-1.4V. So, if you put 12V AC in, you will 10.6V DC out.

4.1.4. Capacitor Filter

The capacitor-input filter, also called "Pi" filter due to its shape that looks like the Greek
letterpi, is a type of electronic filter. Filter circuits are used to remove unwanted or undesired
frequencies from a signal.

A typical capacitor input filter consists of a filter capacitor C1, connected across the rectifier
output. The capacitor C1 offers low reactance to the AC component of the rectifier output while
it offers infinite reactance to the DC component. As a result the AC components are going to
ground. At that time DC components are feed to Regulator.
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AC
input @
-4
é R
Discharging Charging With filter
[\ [\ ‘//\t\/\/\r\:{ Without
filter
.ﬂ/
DC output
AC input

Figure.4.8.Centered Tapped Full-Wave Rectifier with a Capacitor Filter

4.1.5. Voltage Regulator:
A voltage regulator is an electrical regulator designed to automatically maintain a constant
voltage level. It may use an electromechanical mechanism, or passive or active electronic
components. Depending on the design, it may be used to regulate one or more AC or DC
voltages. There are two types of regulator are they.

e Positive Voltage Series (78xx) and

e Negative Voltage Series (79xx)
78xx:’78’ indicate the positive series and ‘xx’ indicates the voltage rating. Suppose 7805
produces the maximum 5V.’05’indicates the regulator output is 5V.
79xx:’78’ indicate the negative series and ‘xx’ indicates the voltage rating. Suppose 7905
produces the maximum -5V.’05’indicates the regulator output is -5V.
These regulators consists the three pins there are
Pinl: It is used for input pin.
Pin2: This is ground pin for regulator

Pin3: It is used for output pin. Through this pin we get the output.
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A 7308 Voltage Regulator

Output

Figure.4.9.Regulator
4.2. LIQUID CRYSTAL DISPLAY

4.2.1. INTRODUCTION TO LCD

A liquid crystal display (LCD) is a thin, flat display device made up of any number of
color or monochrome pixels arrayed in front of a light source or reflector. Each pixel consists
of a column of liquid crystal molecules suspended between two transparent electrodes, and two
polarizing filters, the axes of polarity of which are perpendicular to each other.

Without the liquid crystals between them, light passing through one would be blocked
by the other. The liquid crystal twists the polarization of light entering one filter to allow it to
pass through the other.

A program must interact with the outside world using input and output devices that
communicate directly with a human being. One of the most common devices attached to an
controller is an LCD display. Some of the most common LCDs connected to the controllers
are 16X1, 16x2 and 20x2 displays. This means 16 characters per line by 1 line 16 characters
per line by 2 lines and 20 characters per line by 2 lines, respectively.

Many microcontroller devices use 'smart LCD' displays to output visual

information. LCD displays designed around LCD NT-C1611 module, are inexpensive, easy to
use, and it is even possible to produce a readout using the 5X7 dots plus cursor of the display.

They have a standard ASCII set of characters and mathematical symbols. For an 8-bit
data bus, the display requires a +5V supply plus 10 1/O lines (RS,RW,D7,
D6,D5,D4,D3,02,D1,D0).
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For a 4-bit data bus it only requires the supply lines plus 6 extra
lines(RS,RW,D7,D6,D5,D4). When the LCD display is not enabled, data lines are tri-state and
they do not interfere with the operation of the microcontroller.

O O & & &

.UBUGUBUUBUUUUUUB RS

B

Thiz iz a Zulif

Figure.4.10. 2x16 LCD Display
4.2.2. USES

The LCD s used exclusively in watches, calculators and measuring instruments is the
simple seven-segment displays, having a limited amount of numeric data. The recent advances
in technology have resulted in better legibility, more information displaying capability and a
wider temperature range. These have resulted in the LCD s being extensively used in
telecommunications and entertainment electronics. The LCD s has even started replacing the
cathode ray tubes (CRTs) used for the display of text and graphics, and also in small TV

applications

4.2.3. LCD PIN DIAGRAM

) O Wl

O (O L ) = O — O ST LD O
=== o o7 Wl V22 ) o | £ o | 2
v—lmlml q—nolco r-.|oo O)|C>v—<\ld)<r|

Figure.4.11.Pin Diagram of LCD
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PIN SYMBOL FUNCTION
1 Vss Power Supply(GND)
2 Vop Power Supply(+5V)
3 Vo Contrast Adjust
4 RS Instruction/data register select
5 R/W Data Bus Line
6 E Enable Signal
7-14 DB0-DB7 Data Bus Line
15 A Power supply for LED B/L(+)
16 K Power Supply for LED B/L(-)

4.2.4. CONTROL LINES
EN:

Line is called "Enable.” This control line is used to tell the LCD that you are sending it
data. To send data to the LCD, your program should make sure this line is low (0) and then set
the other two control lines and/or put data on the data bus. When the other lines are completely

Table.4.1. Functions of control lines
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ready, bring EN high (1) and wait for the minimum amount of time required by the LCD
datasheet (this varies from LCD to LCD), and end by bringing it low (0) again.

RS:

Line is the "Register Select” line. When RS is low (0), the data is to be treated as a
command or special instruction (such as clear screen, position cursor, etc.).When RS is high
(1), the data being sent is text data which should be displayed on the screen.

RW:

Line is the "Read/Write" control line. When RW is low (0), the information on the data
bus is being written to the LCD. When RW is high (1), the program is effectively querying (or
reading) the LCD. Only one instruction ("Get LCD status") is a read command. All others are
write commands, so RW will almost always be low.

= LOGIC STATUS ON CONTROL LINES

e E - 0 Access to LCD disabled.
1 Access to LCD enabled.
e RW - 0 Writing data to LCD.

1 Reading data from LCD
e RS - 0 Instructions..

1 Character

= CONTRAST CONTROL
To have a clear view of the characters on the LCD, contrast should be adjusted. To adjust the
contrast, the voltage should be varied. For this, a preset is used which can behave like a variable

voltage device. As the voltage of this preset is varied, the contrast of the LCD can be adjusted.

frack

wipar

tarminals

Figure.4.12. variable resistor
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Potentiometer

Variable resistors used as potentiometers have all three terminals connected. This
arrangement is normally used to vary voltage, for example to set the switching point of a circuit
with a sensor, or control the volume (loudness) in an amplifier circuit. If the terminals at the
ends of the track are connected across the power supply, then the wiper terminal will provide

a voltage which can be varied from zero up to the maximum of the supply.

oy

Figure 4.13.potentiometer symbol
Presets

These are miniature versions of the standard variable resistor. They are designed to be mounted
directly onto the circuit board and adjusted only when the circuit is built. For example, to set
the frequency of an alarm tone or the sensitivity of a light-sensitive circuit, a small screwdriver
or similar tool is required to adjust presets. Presets are much cheaper than standard variable
resistors so they are sometimes used in projects where a standard variable resistor would

normally be used.

Multiturn presets are used where very precise adjustments must be made. The screw must be

turned many times (10+) to move the slider from one end of the track to the other, giving very

.J.—'-"I i
it
2

Preset Symbol F

fine control.

Figure.4.14. preset symbol
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4.3 ESP8266 Wi-Fi Module

This is the heart of the project. Since the project is based on WIFI control of appliances, the
module forms the important component of the project.

The ESP8266 Arduino compatible module is a low-cost Wi-Fi chip with full

TCP/IP capability, and the amazing thing is that this little board has a MCU (Micro
Controller Unit) integrated which gives the possibility to control 1/O digital pins via

simple and almost pseudo-code like programming language. This device is produced by
Shanghai-based Chinese manufacturer, Es press if Systems.

This chip was first time seen in August 2014, in ESP-01 version module, made by AlThinker,
a third-party manufacturer. This little module allows the MCU to connect to WiFi

network and create simple TCP/IP connections. His His very low price (1.7$ — 3.5$) and the
incredible small size attracted many geeks and hackers to explore it and use it in a large
variety of projects. Being a true success, Espressif produces now many versions having
different dimensions and technical specifications. One of the successors is ESP32. You can
find over the internet hundreds of projects and various implementations like home automation,
data logging solutions, robotics, controlling things over the internet, even drones or copters.
4.3.1 ESP8266-01Technical specifications

[1 32-bit RISC CPU: Ten silica Xtensa LX106 running at 80 MHz **

[1 64 KiB of instruction RAM, 96 KiB of data RAM

(1 External QSPI flash — 512 KiB to 4 MiB* (up to 16 MiB is supported)

1 IEEE 802.11 b/g/n Wi-Fi

(1 Integrated TR switch, balun, LNA, power amplifier and matching network

(1 WEP or WPA/WPAZ2 authentication, or open networks

116 GPIO pins **

1 SPI, I2C,

[ I2S interfaces with DMA (sharing pins with GP10)

(1 UART on dedicated pins, plus a transmit-only UART can be enabled on GPI1O2

11 10-bit ADC

** CPU and flash clock speeds can be raised via over clocking on some devices and the 16
I/O are not available in all versions.

XXIV

ESP8266 Arduino Module comes with PCB trace antenna which seems to have a very good
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coverage (I saw a demonstration with more than 1km range!!!). Other version can have onboard
ceramic antenna or an external connector which allows you to attach external Wi-Fi

antennas modules. ESP-01 has only 6 active pins, although the MCU can support up to 16 1/O.
Board dimensions are 14.3 x 24.8 mm.

_fiin}
1.0MB 0.5MB

Figure 4.7: ESP8266 Wi-Fi Module

Over the internet i found that ESP8266 Arduino module, version 01, is sold in two or more
versions, which at first glance seem quite the same. After buying both of them i saw that there
is a difference in size of the flash memory. You may encounter issues while flashing if you
don’t make the proper settings according to board specifications.

Although the board default has 2 available GP10s, you can do some workarounds and use
other MCU available pins if you have the proper soldering tools. | managed to use GPIO 16 in
order to wake up the device after DEEP SLEEP mode (explained later in SLEEP MODES).
XXV

4.3.2 Module pin description (pin out)

RX
Ve
GPIO 0
RESET
CH_PD
GPIO 2
X
GND

Figure 4.8: ESPE266 -01 pin diagram

Pins are arranged in two rows, having 4 on each row. Some models have pin description on

the PCB, which make it simple. On the top row you can find following pins from the left to
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the right:

1. GND (Ground from power supply)

2. GP102 (Digital 1/0 programmable)

3. GPIOO0 (Digital 1/0 programmable, also used for BOOT modes)

4. RX — UART Receiving channel

On the bottom (second row) you can find:

1. TX - UART Transmitting channel

2. CH_PD (enable/power down, must be pulled to 3.3v directly or via resistor)

3. REST — reset, must be pulled to 3.3v)

4. VCC -3.3v power supply

Power supply and current consumption

All esp8266 Arduino compatible modules must be powered with DC current from any kind of
source that can deliver stable 3.3V and at least 250mA. Also logic signal is rated at 3.3v and
the RX channel should be protected by a 3.3v divisor step-down. You should be careful when
using this module with Arduino or other boards which supplies 5v, because this module
usually do not come with overpower protection and can be easily destroyed.
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3.3V

DO(GPIO16) can only be used as gpio read/write, no interrupt supported, no pwm/i2c/ow supported.

The most basic way to use the ESP8266 module is to use serial commands, as the chip is
basically a WiFi/Serial

transceiver. However, this is not convenient. What we recommend is using the very cool
Arduino ESP8266 project,

which is a modified version of the Arduino IDE that you need to install on your computer. This
makes it very

convenient to use the ESP8266 chip as we will be using the well-known Arduino IDE.
Following the below step to

install ESP8266 library to work in Arduino IDE environment.

3.1 Install the Arduino IDE 1.6.4 or greater

Download Arduino IDE from Arduino.cc (1.6.4 or greater) - don't use 1.6.2 or lower version!
You can use your

existing IDE if you have already installed it.

You can also try downloading the ready-to-go package from the ESP8266-Arduino project, if
the proxy is giving you

problems.
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3.2 Install the ESP8266 Board Package

Enter http://arduino.esp8266.com/stable/package_esp8266com_index.json into Additional
Board Manager URLSs

field in the Arduino v1.6.4+ preferences.

-

Preferences
Settings | Network
Sketchibook locaton:
C:\Users Y \Documents \Arduino|

Editor language: | System Default - (requires restart of Arduing)
Editor font size: 18

Show verbose output during: [ compilation || upload
Compiler warnings: Mone =
| Display ine numbers
| Enable Code Folding
| Verify code after upload
| Use external editor
| Check for updates on startup
] Update sketch files to new extension on save (pde -> .ina)
7] Save when verifying or uploadng

Additional Boards Manager LURLS:  http:/farduing. espd 266.com fstable fpackage _espd 26600m_index. json

More preferences can be edited directiy in the file

C:\users\BY \AppDataLocal\Arduing 15\preferences, bxt
(et only when Anduino is not nunning
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£ Boards Manager

Type &l -

Hiore info

Arrow Boards by Axel Elettronica S.r.l.
Baardi meludad im this packaga:
SenaitEvarthing Fas, SmarTubls,

Dwnling bg
Morg o

EMODRD: 7380 by Inowatic-TCT
Bowrde included in thie peckage:

BMolo 2560, Bosrd bassd on ATmege 2560 MCU.

Snlins halp
HMars mnfa

AMEL-Tech Baards by repliced by Arrow Boards
Boards mcluded im this package
SmartEverything Fox

Dnling help

Morg info

mapl}s by ESPEIEE Communiby version LAL0 ITNSTALLLLD

Bcarda mcluded in this packags:

Genaric ESPE2ES Medula, Olemax MOD-WIFI-ESPE2EE]-DEV]), NodaMCU 0.9 (ESP-12 Madula], MedaMCU 1.0 [ESP-12E Madule). Adafruit
HUZZAH ESPAZEE [(ESO-12), ESDrasda Lite 1.0, ESOraids Lite 2.0, Sparkfun Theng, SeeatPea ESP-210, WaMed D1, Waklas Ol mini. ESPAs

[ESP-1Z Medula), ESPne (WROOH-02 Madula). 'Willmls, ESPOuing.

Dnling bels
Maorg b

Select version -

Click 'Tools" -> ‘Board:’ -> ‘Board Manager..." to access this panel.

Scroll down to ¢ esp8266 by ESP8266 Community ’ and click “Install” button to

ESP8266 library package.

install the

Once installation completed, close and re-open Arduino IDE for ESP8266 library to take effect.

3.3 Setup ESP8266 Support

When you've restarted Arduino IDE, select ‘Generic ESP8266 Module’ from the ‘Tools’ ->

‘Board:” dropdown menu.
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-
| Help
Auto Format CirleT
Archive Sketch
" FixEncoding & Reload
A Serial Manitor Ctrl=Shift+M
Serial Plotter Cirds3hift+L. | onece-
Board: "Generic E5PE266 Module” 1 4
Flash Mode: "DI0" 1 Arduing Ethemet
Flash Frequency: “40MHz" |
. CPU Frequency: B0 MHZ" L sy
1 i i Lib®ad Arduing USE
Flash Size: "S12K [54K SPIFFS) I ) )
Debug port: "Disabled” L llw..d T !
Arduing Pro or Pra Mini
[ ! Arduino NG or oldes |
Reset Method: "ck” Y | ekiioo Kabet Contrel Select this
e B ' Arduino Robot Matar
Port ! Arduing Germma
Programmer. "AVRISP miI” P Arduing ARM (32-bits) Boards

Burn Bootleader

Arduine Due (Programming Part)
Arduino Due (Mative LS8 Port)
ESPE2GE Modules

Generic ESPE2EE Modu
Generic ESPE2E5 Module

———r —_— e —
Sketch (Tooks] Help
Auto Format Ctrl+T
‘ Archive Sketch
-sep22; Fix Encoding & Reload
setl Serial Monitor Ctrl+Shift+M
put Serial Plotter Ctrl+Shiftsl. | once: Select this
Board: "Generic ESP8266 Module” 4
Flash Mode: "DIO" L4
Flash Frequency: "40MHz" 4
100] CPU Frequency: "80 MHz" l ¢ B80MHz
put Flash Size: "512K (64K SPIFFS)" .;;ﬁ, -1162-5,1:[: Jdiy:
Debug port: "Disabled” 4
Debug Level: "None" »
Reset Method: "ck" 4
Upload Speed: “115200" ’
Port ’
Programmer: "AVRISP mkll* ’

Burn Bootloader
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Select ‘115200’ baud upload speed is a good place to start - later on you can try higher speeds but 115200 is a good

safe place to start.

(Tooks| Help

’

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

Board: "Generic ESP8266 Module®

Flash Mode: “DIO"

Flash Frequency: "40MHz"
CPU Frequency: "80 MHz"
Flash Sizez "512K (64K SPIFFS)"
Debug port: "Disabled"
Debug Level: "None"

Reset Method: "ck”

Upload Speed: "115200”

Port

Programmer: “AVRISP mkll"
Burn Bootloader

Ctrl+Shift«M
Ctrl+Shift-L

n once:

repeatedly:

1 @ 115200

57600

921600

Select this

Go to your Windows ‘Device Manager’ to find out which Com Port ‘USB-Serial CH340’ is assigned to. Select the
matching COM/serial port for your CH340 USB-Serial interface.

_a'DeviceMamgev
File Action View Help
e w2 Hm

Ll )

4 BY-PC
/% Computer
ca Disk drives
K Display adapters
=4 DVD/CD-ROM drives

& Jungo
= Keyboards
5. Mach3 Pulseing Engi

& Monitors
¥ Network adapters
F Ports (COM & LPT)

N

B Processors

U7 Human Interface Devices
@ IDE ATA/ATAPI controllers

ne

M Mice and other pointing devices

' Communicstions Port (COM1)
| YF Printer Port (LPT1)
{79 USB-SERIAL CH340 (COM11)

[ (To0k) Help

Auto Format Crls T
Archive Sketch

Fix Encoding & Reload

Senial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+ Shift+L

Board: "Generic ESP8266 Module”
Flash Mode: *DIO"

Flash Frequency: "$0MHz"

CPU Frequency: "80 MHz"

Flash Size: 512K (64K SPIFFS)"
Debug port: "Disabled”

Debug Level: "None”

Reset Method: "ck”

Upload Speed: “115200"

Port: "COM11*

Senal ports

com

& Sound, video and game controllers
{M System devices

9 Universal Serial Bus controllers

< WD Drive Management devices

Programmer: "AVRISP midl”
Burn Bootioader

v

comMil

Find out which Com Port is assign for CH340

Select the correct Com Port as indicated on ‘Device Manager”

the above Com Port setting. The CH340 driver can be download from the below site:

https:,

ithub.com/nodemcu/nodemcu-devkit/tree/master/Drivers
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3.4 Blink Test

https://github.com/nodemcu/nodemcu-devkit/tree/master/Drivers

We'll begin with the simple blink test.

Enter this into the sketch window (and save since you'll have to). Connect a LED as shown in
Figure3-1.

void setup() {

pinMode(5, OUTPUT); // GP1005, Digital Pin D1

}

void loop() {

digitalWrite(5, HIGH);

delay(900);

digitalWrite(5, LOW);

delay(500);

}

Now you'll need to put the board into bootload mode. You'll have to do this before each upload.
There is no timeout

for bootload mode, so you don't have to rush!

* Hold down the ‘Flash’ button.

* While holding down ° Flash’, press the ‘RST’ button.

» Release ‘RST’, then release ‘Flash’
When you release the ‘RST’ button, the blue indication will blink once, this means its ready to

bootload.
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This blue indicator will
blink once when
release RTS in step 2.

Step 1: Hold
down this
‘Flash’ button.

Step 2: Press
once and
release this

/ button

Step 3: Release ‘Flash’ button. Now
the board is in ‘bootload’ mode.

Once the ESP board is in bootload mode, upload the sketch via the IDE, Figure 3-2.

Cathode

GND
FLASH 35

Figure3-1: Connection diagram for the blinking test
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o A

File Edit Sketch Toclks Help

} tup() {

nene EEFED00 Module. BO MMz a0MHz D00, 118200, 512K 4K SPIFF

The sketch will start immediately - you'll see the LED blinking. Hooray!

3.5 Connecting via WiFi

OK once you've got the LED blinking, let’s go straight to the fun part, connecting to a
webserver. Create a new sketch

with this code:

Don'’t forget to update:

const char* ssid = "yourssid™;

const char* password = "yourpassword";

to your WiFi access point and password, then upload the same way: get into bootload mode,
then upload code via

IDE.
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II.flr
* Simple HTTP get webclient test
k

I

#include <ESP8266WiFi.h>

Open up the IDE serial console at 115200 baud to see the connection and webpage printout!

D W | Arduinc 147 e
"
Fle B Seetch Teohs Heyp

Click here to Open Seria o
i Meonitor
' lud d h
( * ssad | key in y r W
W * password 632 key in your own W " 5 t password
l
" * host
[
"
pl)
Serial. (115200) ;
y{100) ;
Y r ) WiF w

rg' COMLE

cofnacting to W, handssntes. Som

Fegqueating URL: /projectsS/index.heml
HTTES1.1 200 oK

Dat=: Sat, 24 Sep 2016 03:57:01 oHT

Server: Apache

Last-Modified: Sat, 24 Sep 2018 03:44:33 GMT
Accept-Ranges: bytes

Content-Length: 260

Connection: close

Content-Type: te

andacn
Tear Sive for ESPEZ6E ModaMCU WiFlL modula,
If you can read this message,

Technology

¥ou are successful Sopncted o Wour local WiIFL Access Paint
gngratulaticns |!

N

clo=ing connection

Badzecral v = LI3200 beud
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4. Flashing NodeMCU Firmware on the ESP8266 using Windows

Why flashing your ESP8266 module with NodeMCU?

NodeMCU is a firmware that allows you to program the ESP8266 modules with LUA script.
And you’ll find it very

similar to the way you program your Arduino. With just a few lines of code you can establish
a WiFi connection,

control the ESP8266 GPIOs, turning your ESP8266 into a web server and a lot more.

In this tutorial we are going to use another ESP8266 module with pin header adapter board
which is breadboard

friendly.

ESP8266 Module Breadboard Friendly with Header Connector
4.1 Parts Required:

* ESP8266 Module Breadboard Friendly
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[

@ resr : y ™ ®
® roc 1 g o @
®ciro | I cPos @
@ crio ! b Gpios e
GPID%4 GPIO0
: ;
GPIOY2 GPIO2
1 1
® 0 — " ®
@ v cno @

M PL2303HX USB-UART Cable

@ resy : ' oy @ ————
@ roc 1 ] @ @ —
p— ) CH PO ] 1 omos @ |
@ cros ! b Geos @ -
@ crone : : GPI0D ([ -
@ ooz g om2 @
0 ] < ®
® vcc oND .__l_
+3.3V
ESP8266 Pin Description
CH_PD Pull high, connect to Vcc +3.3V
Vce Power Supply +3.3V
TXD Connect to RXD (white) of PL2303HX USB-Serial converter cable
RXD Connect to TXD (Green) of PL2303HX USB-Serial converter cable
GPIOO Pull low, connect to GND pin
GND Power Supply ground

4.4 Downloading NodeMCU Flasher for Windows

After wiring your circuit, you have to download the NodeMCU flasher. This is a .exe file that
you can download using

one of the following links:

* Win32 Windows Flasher

* Win64 Windows Flasher

You can find all the information about NodeMCU flasher here.
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Open the flasher that you just downloaded and a window should appear (as shown in the following figure).

Double click to run
this program once
installed in your
hard disk folder

a adafruit-io-basics-master.2ip
Q eclipse-cpp-mars-R-win3 e
W' ESPB8266Flasher.exe
E ESPlorer.zip

£ Espressif-ESP8266-DevKit-v2.1.0-x86.exe
B V3.1_win32.2016-08-03_16-31-05.tar.gz

(%]
Operation Config Advanced About Log

COM Port COM26 Flash(F)

AP MAC Waiting MAC

STA MAC Waiting MAC

“Flash” and it should start the flashing process immediately, showing the Modu

cted.

"]
Operation Config Advanced About Log

COM Port COM26 Stop(S)

Page 42



IOT BASED HOME AUTOMATION

[+

Operation Config Advanced About Log

COM Port COM26 Flash(F)

AP MAC A2-20-A6-0F-2A-C0O

STA MAC AO-20-A6-0F-2A-CO

Your ESPE266 module is now loaded with NodeMCU firmware.

Getting Started with the ESPlorer IDE

ESPlorer is an IDE (Integrated Development Environment) for ESP8266 devices. It’s a multi
platform IDE, can be

used in any OS environment, this simply means that it runs on Windows, Mac OS X or Linux.
Supported platforms:

» Windows(x86, x86-64)

* Linux(x86, x86-64, ARM soft & hard float)

* Solaris(x86, x86-64)

* Mac OS X(x86, x86-64, PPC, PPC64)

This software allows you to establish a serial communications with your ESP8266 module,
send commands, and

upload code and much more.

Requirements:

* You need to have JAVA installed in your computer. If you don’t have, go to this

website: http://java.com/download, download and install the latest version. It requires JAVA
(SE version 7

and above) installed.

* In order to complete the sample project presented in this Guide you need to flash your
ESP8266 with

NodeMCU firmware. Refer to chapter-4 in this guide on how to flash the NodeMCU firmware.

Main Resources:
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* ESPlorer Homepage: http://esp8266.ru/esplorer/

» GitHub Repository: https://github.com/4refrOnt/ESPlorer

5.1 Installing ESPlorer

Now let’s download the ESPlorer IDE, visit the following URL:
http://esp8266.ru/esplorer/#download

Grab the folder that you just downloaded. It should be named “ESPlorer.zip” and unzip it.
Inside that folder you

should see the following files:

_lua
_micropython
lib
& ESPlorer.bat 12/16/2014 4:43 AM  Windows Batch File

ESPlorer.jar 1/30/2016 11:28 PM  Executa Jar Fil

__ ESPlorer.Log 3/5/2017 6:11 PM Text Document | KE
ESPlorer.Logl 3/5/2017 1:37 PM 1 File 4 KB

__| version,bxt

Execute the “ESPlorer.jar” file and the ESPlorer IDE should open after a few seconds (the
“ESPlorer.jar” file is what

you need to open every time you want to work with the ESPlorer IDE).

Note: If you’re on Mac OS X or Linux you simply use this command line in your terminal to

run the ESPlorer: sudo
java —jar ESPlorer jar.

When the ESPlorer first opens, that’s what you should see:
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File Emt E°P View Links
| NedaMCU & MigoPython ] AI‘ uasnc I mmaa coMs :J
_‘!Sulﬁ] Commands l Snippets [ Seftings_~ =] =] cl! | Mot | e
- ) = = = 5 - Open crs o ) L® [ ] ween Tarmre
= e & —
Open Relcad Save  Seve.. Com Undo Redo
orR [ | RTS [ | v Donate ‘
:-.»Forma' .‘\
[Z) Fsinto |
G Rebad f
v
| @ IDLE |
(8] SavebRin SwvelComple | | SaveBCompledAun..
| / —
| SeveiCompie A View oo 259 | Vew on £50
] Hep || Ospllo || Ched || FehiD | @
> 3 @ i«
- -

Here’s a rundown of the features the ESPlorer IDE includes:

« Syntax highlighting LUA and Python code.

* Code editor color themes: default, dark, Eclipse, IDEA, Visual Studio.

» Undo/Redo editors features.

* Code Autocomplete (Ctrl+Space).

* Smart send data to ESP8266 (without dumb send with fixed line delay), check correct answer
from ESP8266

after every lines.

* Code snippets.

* Detailed logging.

* And a lot more...

The ESPlorer IDE has a couple of main sections, let’s break it down each one.

In the top left corner you can see all the regular options that you find in any software. Create a
New file, Open a new

file, Save file, Save file as, Undo, Redo, etc.
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;_- ESPlorer v0.2.0-rc5 by 4refrOnt
File Edit ESP View Links ?

[ NodemCu & MicroPytnon | AT-based | RN2483 |

_ISaipts] Commands I Snippets I Settings, /(q

Z # H R B

2 ¢
Open Reload Save Save.. Cose Undo Rede Cut Copy Paste

fion)

In the top right corner you have all the options you need to establish a serial communication
(you’re going to learn

how to use them later in this Guide).
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COMEE |
= = L Bl el L e Egior
T
Open CTs § | ][] e || it Teenieat

& Open
4 =

| o) (RS )

reenshot shows your Code Window, that’s where you write your scripts (your scripts are hiy
mtax).

Hew

‘'ode Window, you have 12 buttons that offer you all the functions you could possible need t¢
b6, Here's the ones yvou’ll use most: “Save to ESP™ and “Send to ESP™.

SaveBiRun | | SaveiCompis ] SavehCompishRun... _I | Save As init
SayeiCompis &I | l Wiswr on ESP | Wiew on ESP _I l Savel Compis
. ' 5 ' v 4 Upload ..

This screenshot shows the Output Window which tells you exactly what’s going on in your ESP8266. You c:
errors and use prints in your code to debug your projects.

[ Format

= FSInfo

‘_'[,‘Re-md

Hep || Chpldo Che 1D Fash 1D (]
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5.2 Schematics

To upload code to your ESP8266, you should connect your ESP8266 to your PL2303HX USB-
UART Programming Cable

like the figure below:

M PL2303HX USB-UART Cal

@ Rrest

1 ]
@ ~c 1 1
pr— ) cH O | ]
@ oo 1 1
@ cron ' .
L ]
@ crouz 1
0 —
® «c
+3.3V
¥
lighton=0
pin=4

gpioc.meode (pin, gpic.OUTPUT)
tmr.alarm(1l,2000,1, function()
if lighton==0 then
lighton=1
gpio.write (pin,gpio.HIGH)
else
lighton=0
gpio.write(pin,gpio.LOW)

Page 48



I0T BASED HOME AUTOMATION

Having your ESP8266+PL2303HX Programmer connected to your computer, go to the ESPlorer IDE:

- ESMvdED-nS by drefrdnt
File Ecit ESP View Link: 7
[ Nodamcu 8 MisoPython | AT-basec | Rnz4s3 |  conax =
_‘Sﬂlﬂlmmmos]smwns]smngs/- l o [>) ) ety -
Open cIs | ) || = Termem

E & H R B 2 ¢ < ®
Open Meiced Zave fave. Cose  Usds Reds  Cut  Copyr

Hap || Ol || el i ]

Look at the top right corner of your ESPlorer |DE and follow these instructions:

1. Press the Refresh button.
2. Select the COM port for your FTDI programmer.
3. Select your baudrate.
4. Click Open.
ESMorer vk 0-rc2 by SrefrDnl
| —————Step 2 -Select COM
o o Step 1 - Refresh
B = = = £ e —
=== om | ﬂj o *|l—————— Step 3 - baudrate
|| Foma I
. Lzl Famio |
.k Reoad |

Step 4 - Click open

Then in the top left corner of your ESPlorer IDE, follow these instructions:

1. Select NodeMCU
2. Select Scripts
3. Create a new filled called “init.lua”
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File Edil ESP View Links 7

[eucsennmen s fsmmasasnt st 1 - Select NodeMCU

Commands | Snippsts | Settings . |
D5 &% H B ]f'ﬁl—-s_ tep 2 - Select Script

Open kooed Sawe Soven Chx deda Pzde

[ .
1ighton=a
2 pin-4 Step 2 - Create a new
io.mode{pin, gpio. OUTRUT) . .
o alarm(1, 1606, 1, Function( ) filed called init.lua
if lighten-<2 then
lightanei
gpio .erite] pin, gpdo.HIGH
else
lighton=i
gpic.write|pin,gpio. L0V

= IEN- T R Py

11 end
S e ]

Copy your Lua script to the code window (as you can see in the Figure below):

File Edit ESP View Links 7

[ noaeucusmerPymon | 47w 20 | Frankensren |

I_[anla’[cammsfsnnmsisma?]
5 % H B B 5 ¢

« B
*ﬁmm‘ﬂm.m_ﬁm_mﬂ“-m

Lighton=@
pl.h-d.

gpio. made(pin, gpio . OUTPUT )
thr.alarm( 1, 2009, 1, functiond )
1f lighton==2 thes

lightonsl
gpdo.write( pin, goio.HIGH)
else Step 1 - COPV
liﬁhtnnzﬁ' . .
goio.write(pin.gpio.Lw) | your code to this window
end
end ]

The next step is to save your code to your ESP8266!

At the left bottom corner click the button “Save to ESP”.

In your output window, it should start showing exactly which commands are being sent to your
ESP8266 and it should

look similar to the Figure below.
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» TSPiorer W0 20-rc2 by decirDat
Fie ESl ESP Wew Lmms 7
" | Cor 2
| senses | [ [ ovonss 7] . , o (e e
& & H R B 5 ¢ 4 B0 B = e -
Cpwn Meced Jes e Com Wnde e Tt Cowy Tem  Se e ot - G600 L
OWR || RS | | ’?
» w= fale,wrrteline
plred wi|liighton=0]));
gelo, mode pln, gplo. OUTFUT v inss]1);
U, alared 1, 2000, 1, Functien | willgprio. node{pin,gpio. OUTPUT)]]);
i l:f&:«‘; then wiliter. alarn(2,2000,1, Function()]]);
2010, weite! pin. goin. N10M) wil if Lighton==i then)]);
elye OUtpUY wil Lighton=111);
lightan-e gplo weltelpin,gpio M)
grio wr bt plo, gpha, LOM) Window : { f ..Tl| ) 4 i in,mpdo. HIGH) 3
“‘"u' w Lighten=0])]);
) gpio. write(pin, gpio.LOw) .
Click Save to ESP to v nd])
" 2 v entd)l]);
upload your init.lua script & J

ile.closel )}

T

You can remove your init.lua, if you type:
file.remove("init.lua") and dlick "Send" ~

Sresess || Gegeety | | Srepl | | Snepsd | | Sneesd

S0 | \ et | s | e
l J I — 2

| seschoem || wevmer || vewores | m\ | e || oo || Oem || Re |
lQS&bEé 'Smiwj,ﬁan J‘im ] ] s nmove(ritius") d ;HI:?: r,..Dn

Note: If you want to delete your “init.lua” file, you can do that easily. Simply type
file.remove(“init.lua”) and press

the button “Send” (see Figure above). Or you can type the command file.format() to remove
all the files saved in your

ESP8266. You can type any commands and send them to your ESP8266 through that window.
After uploading your code to your ESP8266, unplug your ESP8266 from your computer and
power up the ESP8288

module.
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6. NodeMCU GPIO for Lua

The GP1O(General Purpose Input/Output) allows us to access to pins of ESP8266 , all the pins
of ESP8266 accessed

using the command GPIO, all the access is based on the 1/0 index number on the NoddMCU
dev Kits, not the internal

GPIO pin, for example, the pin ‘D7’ on the NodeMCU dev kit is mapped to the internal GPIO
pin 13, if you want to

turn ‘High’ or ‘Low’ that particular pin you need to called the pin number ‘7°, not the internal
GPIO of the pin. When

you are programming with generic ESP8266 this confusion will arise which pin needs to be
called during

programming, if you are using NodeMCU devkit, it has come prepared for working with Lua
interpreter which can

easily program by looking the pin names associated on the Lua board. If you are using generic
ESP8266 device or any

other vendor boards please refer to the table below to know which 10 index is associated to the
internal GP10 of

ESP8266.

Nodemcu | ESP8266 Pin Nodemcu dev | ESP8266 Pin

dev kit kit
DO GPIO16 D7 GPIO13
D1 GPIOS D8 GPIO15
D2 GPIO4 D9 GPIO3
D3 GPIOO D10 GPIO1
D4 GPIO2 D11 GPIO9
D5 GPIO14 D12 GPIO10
D6 GPIO12

DO or GPI1016 can be used only as a read and write pin, no other options like PWM/I2C are
supported by

this pin.

In our example in chapter 5 on blinking the blue LED, the blue LED in connected to GPIO2, it
is defined as

Pin4 (D4) in Lua script.
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7. Web Resources:

* ESP8266 Lua Nodemcu WIFI Module

» ESP8266 Breadboard Friendly Module

» ESP8266 Remote Serial WIFI Module

» PL2303HX USB-UART Converter Cable

NodeMCUi1s an open source loT platform. It includes firmware which runs o1
the ESP8266 from Espressif, and hardware which 1s based on the ESP12 module.The tern
"NodeMCU" by default féférs to the firmware rather than the dev kits. The firmware use:
the Lua scripting language. It is based on the eLua project, and built on the Espressif Non-OS SDk
for ESP8266. It uses many open source projects, such as lua-cjson,and spiffs.

Figure 2: NODE MCU Development board

NodeMCU was created shortly after the ESP8266 came out. On December 30, 2013, Espressi

system began production of the ESP8266. The ESP8266 i1s a Wi-Fi SoC integrated with a Tensilic:
Xtensa LX 106 core,widely used in loT applications

The ESP8266 1s a low-cost Wi-Fi microchip with full TCP/IP stack and microcontroller capability
produced by Shanghai-based Chinese manufacturer, Espressif Systems.
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Wi-Fi module

Figure 3: NODE MCU with inbuilt wifi module

This mod based on the DO pi Please ref NODE M U is an 266 from E CU" by de cripting lan
266. It uses U was crea egan produc X106 core,w 8266 is a lo d by Shangh Pin confi dule
provide the I1/O ind n on the dev fer to the be MCU open so Espressif, a efault refer nguage. It
is s many open ated shortly ction of the widely used ow-cost Wi hai-based Ch Figure 3 guration
es access to dex number v kit is map elow GPIO Figure ource 10T pl and hardwa rs to the f s
based on t n source pro y after the e ESP8266. d in loT app -Fi microch hinese manu 3: NODE
M of NODE o the GPIO on the Nod pped to the i pin maps fo e 2: NODE latform. | are which
firmware ra the eLua pr ojects, such ESP8266 ¢ The ESP82 plications hip with fu ufacturer, E
MCU with in E MCU de (General P deMCU dev internal GP or the index MCU Deve It include
is based ather than roject, and b as lua-cjson came out. O 266 is a Wi ull TCP/IP Espressif Sy
nbuilt wifi m evelopme Purpose Inpu v kits, not t IO pin 16. x«<>gpio map elopment bo es
firmwa on the ES the dev k built on the n,and spiffs On Decemb i-Fi SoC int stack and m stems.
module nt board ut/Output) the internal pping.
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Table 1: Node MCU index<=gpio mapping

10 index Eg';?f 6 10 index ESPB266 pin
0 GPIO16 7 GPIO13
1 GPIOS 8 GPIO15
2 GPIO4 9 GPIO3
3 GPIO0 10 GPIO1
4 GPIOZ2 11 GPIO9
5 GPIO14 12 GPIO10
6 GPID12

DEVKIT

GPI0® H Frash |
oo W
E GPIO13 H RXD2 H wspo |
oprro1s }—{ wxoz }—{ nsexcs |
103 f—{ wxve |
o

Figure 4: NODE MCU pin configuration

3.2.2 Installation of Node MCU & Coding

Mostly these days devices download and install drivers on their own, automatically. Windows
doesn’t know how to talk to the USB driver on the Node MCU so it can’t figure out that the
board is a Node MCU and proceed normally.
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USB device not recognized

The last USE device you connected to this computer malfunctioned,
d IA and Windows does not recognize it.

Recommendation

Try reconnecting the device, F Windows stil does not recognize it. your
device may not be working properiy

Figure 5: Snapshot of the installation process of NODE MCU
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Freferences

Sketchibook location:

C:'Wsers\jayalumar \Documents \Arduing| Browse
Editor language: | System Default w | [regures restart of Arduno])
Editer fort size: 12
Showe werbose output durng: [ compilation [ upload
Compiler warnings: |Mone -

[ Display ke numbers

[] Enable Cade Folding

verify code after upload

[ Uz exterrsl aditor

Chedk for updates on startup

Update gketch files to new extension on save (pde -> ,ino)

[=] Save when verifying or uploading

Additionsl Boards Manager URLs: | Ritp: fjlarduing, esp8 266 comfetable fpackage _espd 266com_index, jeon E

More preferences can be edited directly in the file
Ciisers Yayakumar\AppData \Roaming \Arduine 15\pre ferences. bt

adit crly when Arduiroe i= not running

Figure 7: Arduino IDE preferences

copy the below code in the Additional boards Manager
http://arduino.esp8266.com/stable/package _esp8266com_index json
click OK to close the preference Tab

ED snetch_cecife | Arduine 1.6.5 — =] e
File Lo Skotchs Tools  Hetp
Auto Format CreleT
Archive Soetch
Fie Encodmg S Retonsd
B e L e CRels Shalfs - B —
Board: “NodeMCU 1.0 (E59 - 125 Modute)” i T S SO
! Upload Using: "Sarial 3 S IO
o B ‘ CPU Frequancy: “80 Miex™ y Arcuino Yan

Pt Ve Flasth Secer “aha (304 SPIFFS)

] SRS Sysagay 3 300 1 vt Duernidanove or Dhocirmasles
< Aok Plavves
Prograrmrmer Ases Mega or Maegas 2560
B Bootieedes Arduine Megs ADK
Arcs mo Loonasrdo
Avebasirres Micre

Arduino Robot Motor

Arduine Serrroe
AAO e
-

Figure 8: Arduino IDE board manager installation
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@ Boards Manager ¥

Type Al v |
Intel 686 Boards by Intel
Boards Induded in this package:
Edison.
Mora Infa

>

AMEL-Tech Boards by ANEL Technology
Boards induded in this package:
SmartEveything Fox.

Qnlins help

More info

esp8266 by ESP8266 Community version 2,.0,0 INSTALLED

Boards Indluded in this package:

Generic ESPB266 Module, Olimex MOD-WIFI-ESPE266(-DEV), NodeMCU 0.9 (ESP-12 Modue), NodeMCU 1.0 (ESP-12E Module),
Adafruit FUZZAR ESPS26E (ESP-12), SparkFun Thing, SwestPea ESP-210, WeMes D1, WeMos D1 mini.

Qnling help

More info

Figure 9: ESP 8266 board installation in Arduino

Navigate to esp8266 by esp8266 community and install the software for Arduino.
Once all the above process had been completed we are ready to program our esp8266 with Arduino
IDE.

ARDUINO

Figure 10: NODE MCU interfacing with Arduino

Page 58



I0T BASED HOME AUTOMATION

CP2102 Driver

Figure 6: Driver Installation for NODE MCU

3.2.3 Interfacing of node mcu with arduino IDE

Firstly open the Arduino IDE. Go to files and click on the preference in the Arduino IDE

3.4 Circuit Diagram

Globally Controlled multiple relays using NODEMCU ~ setors  coous

» | 4 » »
gopgogog
-

i
iuulu

Relay Driver 4

Iy
A0

.....

NODE MCU P
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CHAPTER 5
SOFTWARES

5.1 Introduction to Arduino IDE

Arduino is a prototype platform (open-source) based on an easy-to-use hardware and
software. It consists of a circuit board, which can be programmed (referred to as a
microcontroller) and a ready-made software called Arduino IDE (Integrated Development
Environment), which is used to write and upload the computer code to the physical board.

The key features are:

e Arduino boards are able to read analog or digital input signals from different sensors
and turn it into an output such as activating a motor, turning LED on/off, connect to the
cloud and many other actions.

e You can control your board functions by sending a set of instructions to the
microcontroller on the board via Arduino IDE (referred to as uploading software).

e Unlike most previous programmable circuit boards, Arduino does not need an extra
piece of hardware (called a programmer) in order to load a new code onto the board.
You can simply use a USB cable.

e Additionally, the Arduino IDE uses a simplified version of C++, making it easier to
learn to program.

e Finally, Arduino provides a standard form factor that breaks the functions of the micro-
controller into a more accessible package.

After learning about the main parts of the Arduino UNO board, we are ready to learn how to
set up the Arduino IDE. Once we learn this, we will be ready to upload our program on the

Arduino board.
5.1.1 Arduino data types:

Data types in C refers to an extensive system used for declaring variables or functions
of different types. The type of a variable determines how much space it occupies in the storage
and how the bit pattern stored is interpreted.

The following table provides all the data types that you will use during Arduino

programming.

Void:
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The void keyword is used only in function declarations. It indicates that the function is

expected to return no information to the function from which it was called.
Example:
Void Loop ()

{

/I rest of the code
}
Boolean:

A Boolean holds one of two values, true or false. Each Boolean variable occupies one

byte of memory.
Example:

Boolean state= false ; // declaration of variable with type boolean and initialize it with

false.

Boolean state = true ; // declaration of variable with type boolean and initialize it with

false.

Char:A data type that takes up one byte of memory that stores a character value. Character
literals are written in single quotes like this: 'A" and for multiple characters, strings use double
quotes: "ABC".

However, characters are stored as numbers. You can see the specific encoding in the
ASCII chart. This means that it is possible to do arithmetic operations on characters, in which
the ASCII value of the character is used. For example, ‘A" + 1 has the value 66, since the ASCII

value of the capital letter A is 65.
Example:

Char chr_a = ‘a’ ;//declaration of variable with type char and initialize it with character
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Char chr_c = 97 ;//declaration of variable with type char and initialize it with character
97

Unsigned char:

Unsigned char is an unsigned data type that occupies one byte of memory. The

unsigned char data type encodes numbers from 0 to 255.
Example:

Unsigned Char chr_y = 121 ; // declaration of variable with type Unsigned char and

initialize it with character y

Byte:

A byte stores an 8-bit unsigned number, from 0 to 255.
Example:

byte m = 25 ;//declaration of variable with type byte and initialize it with 25
int:

Integers are the primary data-type for number storage. int stores a 16-bit (2-byte) value.
This yields a range of -32,768 to 32,767 (minimum value of -2715 and a maximum value of
(2715) - 1).

The int size varies from board to board. On the Arduino Due, for example, an int stores
a 32-bit (4-byte) value. This yields a range of -2,147,483,648 t0 2,147,483,647 (minimum value

of -2”31 and a maximum value of (2°31) - 1).
Example:

int counter = 32 ;// declaration of variable with type int and initialize it with 32.
Unsigned int:

Unsigned ints (unsigned integers) are the same as int in the way that they store a 2 byte
value. Instead of storing negative numbers, however, they only store positive values, yielding
a useful range of 0 to 65,535 (2"*16) - 1). The Due stores a 4 byte (32-bit) value, ranging from
0t0 4,294,967,295 (2732 - 1).
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Example:

Unsigned int counter=60 ; // declaration of variable with type unsigned int and initialize
it with 60.

Word:

On the Uno and other ATMEGA based boards, a word stores a 16-bit unsigned number.

On the Due and Zero, it stores a 32-bit unsigned number.
Example

word w = 1000 ;//declaration of variable with type word and initialize it with 1000.
Long:

Long variables are extended size variables for number storage, and store 32 bits (4
bytes), from 2,147,483,648 to 2,147,483,647.

Example:

Long velocity= 102346 ;//declaration of variable with type Long and initialize it with
102346

Unsigned long: Unsigned long variables are extended size variables for number storage and
store 32 bits (4 bytes). Unlike standard longs, unsigned longs will not store negative numbers,
making their range from 0 to 4,294,967,295 (2732 - 1).

Example:

Unsigned Long velocity = 101006 ;// declaration of variable with type Unsigned Long
and initialize it with 101006.

Short:

A short is a 16-bit data-type. On all Arduinos (ATMega and ARM based), a short stores
a 16-bit (2-byte) value. This yields a range of -32,768 to 32,767 (minimum value of -2"15 and

a maximum value of (215) - 1).

Example:
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short val= 13 ;//declaration of variable with type short and initialize it with 13
Float:

Data type for floating-point number is a number that has a decimal point. Floating-point
numbers are often used to approximate the analog and continuous values because they have

greater resolution than integers.

Floating-point numbers can be as large as 3.4028235E+38 and as low as
3.4028235E+38. They are stored as 32 bits (4 bytes) of information.

Example:
float num = 1.352;//declaration of variable with type float and initialize it with 1.352.
Double:

On the Uno and other ATMEGA based boards, Double precision floating-point number
occupies four bytes. That is, the double implementation is exactly the same as the float, with
no gain in precision. On the Arduino Due, doubles have 8-byte (64 bit) precision.

Example:

double num = 45.352 ;// declaration of variable with type double and initialize it with
45.352.

In this section, we will learn in easy steps, how to set up the Arduino IDE on our

computer and prepare the board to receive the program via USB cable.

Step 1: First you must have your Arduino board (you can choose your favorite board) and a
USB cable. In case you use Arduino UNO, Arduino Duemilanove, Nano, Arduino Mega2560,
or Diecimila, you will need a standard USB cable (A plug to B plug), the kind you would

connect to a USB printer as shown in the following image.
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Figure 5.1: USB Cable
Step 2: Download Arduino IDE Software.

You can get different versions of Arduino IDE from the Download page on the Arduino
Official website. You must select your software, which is compatible with your operating

system (Windows, 10S, or Linux). After your file download is complete, unzip the file.

- =

Opening arduing-nightly-windows.zip @
You have chosen to open:
g arduino-nightly-windows.zip

which is: WinRAR ZIP archive (148 ME)
from: https:.//downloads.arduino.cc

What should Firefox do with this file?

) Openwith | WinRAR archiver (default) -

@ Save File

[] Do this auternatically for files like this from now on.

oK l I Cancel

Step 3: Power up your board.

The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw power
from either, the USB connection to the computer or an external power supply. If you are using
an Arduino Diecimila, you have to make sure that the board is configured to draw power from
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the USB connection. The power source is selected with a jumper, a small piece of plastic that
fits onto two of the three pins between the USB and power jacks. Check that it is on the two
pins closest to the USB port. Connect the Arduino board to your computer using the USB cable.
The green power LED (labeled PWR) should glow.

Step 4: Launch Arduino IDE.

After your Arduino IDE software is downloaded, you need to unzip the folder. Inside
the folder, you can find the application icon with an infinity label (application.exe). Double
click the icon to start the IDE.

@Uv‘ » Computer » Local Disk (C:) » Program Files » Arduinc »

Organize ¥ Include in library v Share with v Burn New folder
jame )ate modified vpe Siz
e Eavoriis Name Date medified Type Size
Bl Desktop drivers File folder
& Downloads examples File folder
=] Recent Places hardware File folder

java

4 Libraries lib
| Documents libraries
“, Music reference
=/ Pictures tools /
B videos & arduino Application 844 KB
@ arduino_debug Application
1% Computer %] cygiconv-2.dIl Application extens...
&, Local Disk (C:) %) cygwind.dil App! 1,329 KB
- MTC MASTER (D:) 1% libusb0.dll A 43KB
= INFORMATION TECHNOLOG || revisions T 9 KB
%) ndxSerial.dll n 76 KB
“ﬁ Network @ uninstall Application 402 KB

Step 5: Open your first project.
Once the software starts, you have two options:
e Create a new project.

e Open an existing project example.

To create a new project, select File --> New. To open
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2 sketch_nov29a | Arduino 105 [E=R N = 2 sheteh nova®a | Arduino 105 = =
[File] Edit Sketch Tools Help File Edit Sketch Tools Help

Mew Ctrl=M > ¥

Open... Ctrl+Q

Sketchboak ¥ sketch_nov29a

Examples ] =

Chose Ctrl+W

Save Ctrl+§

Save As... Ctrl+Shift+5

Upload Ctrl+l

Upload Using Programmer  Ctrls Shift« U ﬁ

Page Setup Ctrl+Shift«P

Prnt Ctrl+P

Preferences Ctrl+ Comma

Quit Ctrl=

Ardisino Uno

To open an existing project example, select File -> Example -> Basics -> Blink.

01 Basics

» AnalogResdSerial
02.Digital C BareMinimum
03.Analog ’ Bnk
04.Communication » DigitaiReadSerial
05.Control » Fade
-~ = 05, Sensors 3 ReadAnalogVoltage
2D Biink | Arduino 106 A
07,Duplay » =
[File) Edit Sketch Tools Help r R ———_
il CeteN S ' bk i 108 [ESREER
ew R
Opan o w.use 4 Fie £t Shatch Tools Help
Sketchbook | |EhER 2 00 BEEE
ArdunolsP -~
Examples 3 Tasssy 5 al
eensy
Close Ctrie W
Save Curts S AccelStepper »
Save As... Ctrie Shifte$S Adafru CC3000 »
Upload Cut-U Adafrua_1LB340 »
Upload Using Prograrnmer  Ctre Shift+U Adafruie B3 »
Adatrut NeoPixel »
P i+ Shift«P L
oge et Cte it Adafruit_oRFS001 &
Print CtideP
Adafruit RAZSTS  »
Preferences Ctris Comma Adafruit_SS01306 »
Adafruie STI735  »
Quit CirleQ ied o 13
Adsfrust STMPES10 » => o
Adafruit_V51053 4 "
ADC » wetwp () |
ARSoftSenat v - L
e - ' 1=Mode(led, O
Audio » -
+ '
Bounce 3
CapacitiveSenzor  »
DruSimple »
Dogled »
DS1307RTC »
DS18B20Emulator
v

Here, we are selecting just one of the examples with the name Blink. It turns the LED
on and off with some time delay. You can select any other example from the list.

Page 67



IOT BASED HOME AUTOMATION

Step 6: Select your Arduino board.

To avoid any error while uploading your program to the board, you must select the

correct Arduino board name, which matches with the board connected to your computer.

Go to Tools -> Board and select your board

Teensy 3.2/31

Teensy 3.0

Teensy LT
Blink | Arduino 1.0.6 Teensy 2.0
File Edit Sketch Help Teensy++ 2.0

00 ! Auto Format Ctrl=T Arduine Uno

Archive Sketch Arduino Duemilanowve w/ ATmega328

Elink & Fix Encoding & Reload Arduino Diecimila or Duemilanove w/ ATmegalbs
Serial Monitor Ctrl+ Shift+ M Arduino Nano w/ ATmega328
Arduine Mano w/ ATmegal6s
Board: "Arduino Uno” U] Arduino Mega 2560 or Mega ADK
Serial Port b Arduino Mega (ATmegal 280)
USB Type > Arduino Leonardo
CPU Speed L2 Arduino Esplora
Keyboard Layout L4 Arduino Micro
P » Arduino Mini wy ATmega328

Arduino Mini wy/ ATmegal68

Arduino Ethernet

Arduino Fio

Arduino BT w/ ATmega328

Arduine BT w/ ATmegalesd

LilyPad Arduino USBE

LilyPad Arduino w,/ ATmega323

LilyPad Arduino w/” ATmegalbs

Arduino Pro or Pro Mini (5Y, 16 MHz) w/ ATmega328
Arduine Pro or Pro Mini (5V, 16 MHz) w/ ATmegalss
Arduine Pro or Pre Mini (2.3V, 8 MHz) w/” ATmega328
Arduine Pro or Pro Mini (2.3V, 8 MHz) w/ ATmegals8
Arduine MG or older w/ ATmegalss

Arduine MG or clder w/” ATmegad

Arduino Rebot Cantrol

Burn Bootloader

Arduino Robot Motor

Here, we have selected Arduino Uno board according to our tutorial, but you must

select the name matching the board that you are using
Step 7: Select your serial port.

Select the serial device of the Arduino board. Go to Tools ->Serial Port menu. This is
likely to be COM3 or higher (COM1 and COMZ2 are usually reserved for hardware serial ports).
To find out, you can disconnect your Arduino board and re-open the menu, the entry that

disappears should be of the Arduino board. Reconnect the board and select that serial port.
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i ot

Blink | Arduino 1.0.6

File Edit Sketch Help

Auto Format Ctrl+T

Archive Sketch

Fix Enceding & Reload

Serial Monitor Ctrl+Shift+M i
Board: "Arduing Ung” k

Serial Port r ComM1

USE Type 3 Cam2

CPU Speed 3 COmM3

Keyboard Layout k

Programrmer r

Burn Bootloader

Arduing Uno on COMAG

Step 8: Upload the program to your board. Before explaining how we can upload our
program to the board, we must demonstrate the function of each symbol appearing in the
Arduino IDE toolbar.
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A- Used to check if there is any compilation error.
B- Used to upload a program to the Arduino board.
C- Shortcut used to create a new sketch.

D- Used to directly open one of the example sketch.
E- Used to save your sketch.

F- Serial monitor used to receive serial data from the board and send the serial data to the
board.

Now, simply click the "Upload" button in the environment. Wait a few seconds; you will
see the RX and TX LEDs on the board, flashing. If the upload is successful, the message "Done
uploading™ will appear in the status bar.

Note: If you have an Arduino Mini, NG, or other board, you need to press the reset button
physically on the board, immediately before clicking the upload button on the Arduino

Software.
Arduino programming structure

In this chapter, we will study in depth, the Arduino program structure and we will learn
more new terminologies used in the Arduino world. The Arduino software is open-source. The
source code for the Java environment is released under the GPL and the C/C++ microcontroller

libraries are under the LGPL.

Page 70



I0T BASED HOME AUTOMATION

Sketch: The first new terminology is the Arduino program called “sketch”.

Structure

Arduino programs can be divided in three main parts: Structure, Values (variables and
constants), and Functions. In this tutorial, we will learn about the Arduino software program,

step by step, and how we can write the program without any syntax or compilation error.
Let us start with the Structure. Software structure consist of two main functions:

e Setup() function

e Loop() function

=% sketch_nowv29a | Arduine 1.0.6 | = [ e

File Edit Sketch Tools Help

sketch_novida &

-

woid =zetup ()

Arduine Uno on COMMAS

Void setup ()
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PURPOSE:

The setup() function is called when a sketch starts. Use it to initialize the variables, pin
modes, start using libraries, etc. The setup function will only run once, after each power up or

reset of the Arduino board.
INPUT
OUTPUT

RETURN

Void Loop ()

{
k

PURPOSE:

After creating a setup() function, which initializes and sets the initial values, the loop()
function does precisely what its name suggests, and loops secutively, allowing your program
to change and respond. Use it to actively control the Arduino board.

INPUT
OUTPUT

RETURN
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CHAPTER 6
RESULTS

6.1. RESULTS

After the successful connection from home applications to the server, the data of sensor
are sent to the web server for monitoring of the system. The figure shows the web server page
which will allow us to monitor and control the system. By entering the assigned IP address in

the web browser this web server page will appear.

The web server gives the information about the temperature in different places of the
house and motion state in the house. It also gives the status of the various electrical appliances
like light, fan etc which we can control remotely. The main result we can see, by operating
devices from anywhere with our hands.
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CHAPTER 7

CONCLUSION
7.1. CONCLUSION

The next phase for the home automation market will occur based on a few key
improvements in the technology available in automation, such as improvements in wireless
automation solutions as well as lowering of price points as the market begins to accept home

automation usage in larger volumes.

Some trends that we foresee for this phase of the industry are Big companies like
Philips, siemens & scheider will eventually bring out fairly mass market automation produces
with appealing user interface hot a lower price point today, and more people will be able to
afford the products. Some foreign players will have niche in high and automation and focus

fun the premium market.
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